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License Agreement
1. License. The application, demonstration, system and other software accompanying this 
License, whether on disk, in read-only memory, or by any other media (the “Software”) 
and the related documentation are licensed to you by Catamount Software. You own the 
media on which the Software is recorded but Catamount Software and/or Catamount 
Software’s Licenser(s) retain title to the Software and related documentation. This 
License allows you to use the Software on a single Palm Computing Device, and make one 
copy of the Software in machine-readable form for backup purposes only. You must 
reproduce on such copy Catamount Software’s copyright notice and any other 
proprietary legends that were on the original copy of the Software. You may also 
transfer all your license rights in the Software, the backup copy of the Software, the 
related documentation and a copy of this License to another party, provided the other 
party reads and agrees to accept the terms and conditions of this License.

2. Restrictions. The Software contains copyrighted material, trade secrets and other 
proprietary material and in order to protect them, you may not decompile, reverse 
engineer, disassemble or otherwise reduce the Software to a human-per-ceivable form. 
You may not modify, network, rent, lease, loan, distribute or create derivative works 
based upon the Software in whole or in part.

3. Termination. This License is effective until terminated. You may terminate this License 
at any time by destroying the Software and related documentation. This License will 
terminate immediately without notice from Catamount Software if you fail to comply 
with any provision of this License. Upon termination you must destroy the Software and 
related documentation.

4. Export Law Assurances. You agree and certify that neither the Software nor any other 
technical data received from Catamount Software, nor the direct product thereof, will be 
exported outside the United States except as authorized and as permitted by the laws 
and regulations of the United States. If the Software has been rightfully obtained by you 
outside of the United States, you agree that you will not re-export the Software nor any 
other technical data received from Catamount Software, nor the direct product thereof, 
except as permitted by the laws and regulations of the United States and the laws and 
regulations of the jurisdiction in which you obtained the Software.

5. Government End Users. If you are acquiring the Software on behalf of any unit or 
agency of the United States Government, the following provisions apply. The 
Government agrees: (i) if the Software is supplied to the Department of Defense (DoD), 
the Software is classified as “Commercial Computer Software” and the Government is 
acquiring only “restricted rights” in the Software and its documentation as that term is 
defined in Clause 252.227-7013(c)(1) of the DFARS; and (ii) if the Software is supplied 
to any unit or agency of the United States Government other than the DoD, the 
Government’s rights in the Software and its documentation will be as defined in Clause 
52.227-19(c)(2) of the FAR or, in the case of NASA, in Clause 18-52.227-86(d) of the 
NASA Supplement to the FAR.

6. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of 
the Software is at your sole risk. The Software and related documentation are provided 
“AS IS” and without warranty of any kind and Catamount Software and Catamount 
Software’s Licenser(s) (for the purposes of provisions 6, Catamount Software and 
Catamount Software’s Licenser(s) shall be collectively referred to as “Catamount 
Software”) EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Catamount 
Software DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
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SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF 
THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 
DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, Catamount 
Software DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR 
RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY Catamount Software OR AN AUTHORIZED REPRESENTATIVE 
OF Catamount Software SHALL CREATE A WARRANTY OR IN ANY WAY 
INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE,YOU (AND NOT Catamount Software OR AN AUTHORIZED 
REPRESENTATIVE OF Catamount Software) ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION IF IMPLIED WARRANTIES, SO THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU.

7. Limitation of Liability.UNDER NO CIRCUMSTANCES INCLUDING 
NEGLIGENCE, SHALL Catamount Software BE LIABLE FOR ANY INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR 
INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTATION, EVEN IF 
Catamount Software OR AN AUTHORIZED REPRESENTATIVE OF Catamount 
Software HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. In no event shall 
Catamount Software’s total liability to you for all damages, losses, and causes of action 
(whether in contract, tort (including negligence) or otherwise) exceed the amount paid by 
you for the Software.

8. Controlling Law and Severability. This License shall be governed by and construed in 
accordance with the laws of the United States and the State of Vermont, as applied to 
agreements entered into and to be performed entirely within Vermont between Vermont 
residents. If for any reason a court of competent jurisdiction finds any provision of this 
License, or portion thereof, to be unenforceable, that provision of the License shall be 
enforced to the maximum extent permissible so as to effect the intent of the parties, and the 
remainder of this License shall continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement between the parties 
with respect to the use of the Software and related documentation, and supersedes all 
prior or contemporaneous understandings or agreements, written or oral, regarding such 
subject matter. No amendment to or modification of this License will be binding unless in 
writing and signed by a duly authorized representative of Catamount Software.
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1. 
Introduction

MPG is a log book for your car. MPG replaces the little notepad in your 

glovebox with an intelligent tracker. MPG tracks fuel, oil changes, tune-ups, 

inspections, tire rotations, windshield wipers, car washes trips, and other 

miscellaneous expenses for your car. It generates statistics such as average 

miles per gallons, total cost of gas, and average price of gas. Fuel economy is 

calculated for the fuel entries. Time, distance and time per distance are 

calculated for trips. Trip reports can be generate for tax purposes. MPG 

reduces redunant data entry by integrating with PocketMoney, a personal 

finance program also by Catamount Software.

Know your Palm OS Device
This manual assumes that you are already familiar with basic Palm OS 
operation including:

• Writing and editing.

• Launching applications.

• The Up and Down scroll buttons.

• Installling Software on your Palm device.

If not, consult your Palm Computing Device User Manual before you proceed.
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Purchasing MPG
There are several ways to purchase MPG. 

• Credit Card Online - Kagi processes credit card payments for Catamount 
Software. Goto <http://order.kagi.com/?HM> if you have a credit card 
and wish to pay online. This is typically the fastest way to pay for the 
software. It still takes a few days for me to turn around your registration 
code.

• Cash - I’ll accept cash payments in any currency that is equivalent to the 
current price of MPG. Send to address below.

• Checks/Cheques - I can only accept US checks and Canadian cheques. 
Canadian cheques need to take into account the current exchange rates.

• International Postal Orders - I can accept IPOs. 

Mail payments to:
Catamount Software
PO Box 8276
Essex VT 05451, USA

Registering MPG

The registration code is based on your 
device’s hotsync name. This is mostly 
likely your name. I will email a code 
to you. Enter it in the Registration 
Code field on the About Screen 
accessed  from the Options menu.
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2.
Basics

This chapter covers basic MPG transaction operations and screens. Refer to 
“Features” for full coverage of all of MPG’s features.

Vehicles List Screen

You may create as manyvehicles as needed in the Vehicle List screen by 
tapping the New button (See Vehicle Prefs” for more information).  

• Vehicle Info Button - opens the Vehicle Info Screen. 

•  New Vehicle - button creates a new vehicle.

Accessing a particular Vehicle Log

To access the corresponding Register  from the Vehicle Screen, simply tap the 
desired vehicle name.
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Record Types

MPG provides three types of transactions using the Data Entry Slip:

• Fuel - used whenever you add gasoline or other forms of fuel to your vehicle. 
Tracks the fuel economy.

• Service - used when you change your oil, tune up the vehicle, or other 
miscellaneous expenses to the car.

• Trip - used to track distance and time traveled for business purposes, 
measurement purposes, or to track your average speed on long trips.

Data Entry Screen

The Data Entry Screen looks similar to this for Fuel, Service, and Trip 
records:

Tips

Record Type

Amount

Fuel economy

Folder

Memo/NotesDelete

Octane
Gallons or Litres

Cost per Gal or Litre

Trip MileageOdometer
Location

Account/Payment Type
Date/Time

Save

Don't Save Post to PocketMoney

It includes the following elements:

• Folder - the folder that the current transaction is filed in. By default, 
this is “Unfiled”.

• Record Type - either Fuel, Service, or Trip. 

• Date/Time - the date & time that the transaction took place. Tap on the 
date or time to popup change the date/time. Transactions are listed by 
Date, so by modifying the date/time you can reorder the way checks are 
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H i n t :

H i n t :

listed.

• Payment - the name of the account that you  paid for service with (e.g., 
checking, Visa, or any other one that you have created). Tap on the 
Payment  picker to select an account for the transaction. If 
PocketMoney is installed and you have Use PocketMoney turned on in the 
Prefs then the popup will list your PocketMoney accounts.

You can use folders to keep your personal expenses separate from your 
business expenses for expense reporting. 

• Location - the place the fillup or service was rendered or the location of 
where you are at during your trip. Write or key in a name or tap on the 
Location  to select a location for the record or to access the List Editor. 

• Odometer- the current mileage. 

• T- the trip mileage. If you enter the trip mileage MPG will calculate the 
odometer based on the last recorded entered of this type. 

Activate “Auto-add to popups” in Prefs to save time editing the popup 
list.

• Amount - the amount of the fillup/service/toll. 

• Memo/Notes/Description - Several lines of additional information of 
your choice about the transaction.

• Post To PocketMoney - Tap the $  to post this transaction to PocketMoney. 
With just one tap you can save a lot of duplicate data entry.

Fuel Extras

• Cost/Gal  or Cost/L- the price per gallon (or price per Litre if you 
have a non-US Unit selected in the Vehicle Prefs). When entered the Gallons 
are calculated by dividing the Amount by the Cost/Gal.
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• Gallons  or Litres- the number of gallons (or Litres depending on the 
Unit selected in the Vehicle Prefs). When entered the Cost/Gal is calculated 
by dividing the Amount by the Gallons.

• Gas Can - the partial fillup gas can toggles between full and 
partial in order to correctly calculate the fuel economy. If you fill up your 
tank then the gas can should be set to full. If you do not completely fill up 
your tank then set the gas can to partial.

• Octane - the octane of the fuel being used.

• mpg - the fuel economy in miles per gallons (or L/100km  depending 
on the Unit selected in the Vehicle Prefs).

Service Extras
• Service -  the service performed such as oil changes. You can also use 

this for miscellaneous costs such as speeding tickets!

Trip Extras
• Purpose - nature of the trip. Used for the 

statistics to generate how many miles you 
used your vehicle for a specific purpose. 
The main use for this field is to allow you 
to categorize trips for tax purposes.

• Trip Point - location in trip. All trips must 
have a Start Trip and End Trip point. Trip 
Point’s popup menu is based on the last trip 
entry, depending on what your last trip 
entry was the popup will change 
accordingly. 

Start Trip - When you start a trip you set trip point to Start Trip.

Pause Trip - This allows you to take breaks in a trip. It can be used for pit 
stops or meetings with clients. Time and distance are ignored for mph and 
distance calculations during a pause/resume trip entries.

Resume Trip - The companion of Pause Trip is resume. When you start 
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traveling again enter a new Resume trip entry.

Distance Markers  - Used for measuring out directions. It gives you a good 
way to enter landmarks if you are giving directions. If I’m using MPG to 
record directions I would start trip, distance marker (turn right), distance 
marker (turn left at 3rd light), ..., end trip.

End Trip- When you end a trip you set trip point to End Trip.

• Time - The time elapsed since the start of the trip. (Does not include the 
time wasted in the Pause/Resume pit stops.)

• mph - Miles per hour is calculated since the last trip point. The average 
mph can be more useful than just a fancy fact...the next time a cop pulls 
you over you can show the officer that you have only been averaging 65 
miles per hour since mile marker 23 which was 15 miles back. I haven’t 
had to try this yet, but if MPG gets anyone out of a ticket because of this I 
would like to know about it and possibly receive a big Christmas present 
for the money that MPG just saved you. ;-) 

Trip Example 
Question from user: “Maybe it's just me, but I can't seem to figure
out how the Trip screen works.  Do you create one for the start and one for the 
end? What info goes into the cost? Could you give me an example so I might 
understand it.”

Answer: You need to create one entry for the start of the trip and one for the 
end of the trip. The majority of the time you will not enter anything into the 
cost field, but I left the cost field there because once in a while I will enter 
the amount I pay for tolls in the trip section. An example would be (I'm at 
home, go to work, and return home): 

1. I'm at home and I get into my vehicle.While I'm waiting for my vehicle to 
warm up I add a new trip item. Tap New and tap Trip. 

a. The record defaults to start trip - unless you have a start trip entered 
without a corresponding end trip in which case it will default to end 
trip. 

b. Thepayment method will be blank - most of the time you will not be 
entering a cost, hence no payment method. 

c. Enter "Home" for the location. You can either write it into the location 
field or if it is a common starting or end point then you can add it to the 
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popup list. 
d. Enter the odometer. 
e. If I know the route to work Iwill be taking I enter the route into the notes 

field. Most of the time I leavethis blank until I am actually taking the 
route I think I will be taking. I also might enter weather conditions and 
traffic conditions. (rain/heavy traffic/accident) 

2.When I arrive at work I enter the end trip. Tap New and tap Trip. 
a. The record shoulddefault to End Trip because Start Trip was the last 

trip item entered. 
b. Enter "Work" for the location. 
c. Enter the odometer. (If you know the trip distance then you can enter the 

distance in the “T:” field and the odometer will be updated.)

3. I'm at work or a job site and now I must enter a new trip to continue on. The 
easiest way to do this to avoid duplicate data entry is to choose "Duplicate" 
from the Record Menu. 

a. The record should default to Start Trip because End Trip was the last 
trip. 

b. The location will still be "Work" 
c. The odometer will still be the same 
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The Vehicle Log Screen

The Log screen provides a list of  records. 

Folder

Records

Column Headings

Vehicle Name

Return to
Vehicle List

Scroller

New Record

• Vehicle Name - the name of the vehicle that you are viewing. This will 
be set to “All Vehicles” if you have choosen “All Records” in the View 
Menu or you set Vehicle to “All Vehicles” in a Custom Filter.

• Middle Column Heading - the middle column ( Odo/Service) can 
display different fields of the transactions. [Memo, Odometer, 
Odo/Service, Pay/Loc, Service, Vehicle/Odo, Vehicle/Service].

• Right Column Heading - the righ column ( Amount) can display the 
Amount or the Fuel Economy. By displaying fuel economy you can catch 
trends of your fuel economy dropping which might mean it is time for a 
tune-up .

• New - tap this button to create new transaction.

• OK - tap this button to return to the Vehicle List Screen.

Accessing a particular Data Entry Slip

Tap the desired record to access the corresponding Data Entry Slip.
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Menus

Tap the Menu button  to access the menus in MPG. Depending on what 
screen you are in will determine what menu is displayed. 

View

• All Records - displays all of the records regardless of the vehicle.

• Create Custom Filter... - opens the Custom Filter Screen in order to create 
a new filter. (See “Custom Filters” for futher information).

 • Select Custom Filter... - popups  a list of custom filters that have been 
saved in the Custom Filter Screen.

 • Transaction at Date- pops up a date picker and displays records starting 
at the selected date in the log.

 • First Transaction - moves to the first record. (Same as moving the scroll 
bar to the very top.)

 • Last Transaction- moves to the last record. (Same as moving the scroll 
bar to the very bottom.)

 • New Transaction- creates a New record and opens the Edit Record 
window.
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Options

• IR Sync - beam transactions to MPG on another Palm. (See “HotSync 
Scenarios” for further information).

• Preferences - opens the MPG Preferences screen, allowing you to change 
the default behavior of some features. (See “Preferences” for further 
information).

• About - displays a screen with the version of MPG and technical support 
contact information.

Tools

• General Statistics - generates a report of vehicle expenses and fuel 
economy.

• Trip Statistics - generates a trip report summarized by trip purpose.

• Last Service - generates a report of the last mileage and date a service 
was performed on the vehicle.

• Delete Records... - deletes all of the records in the currently found set. 
Use the Custom Filter option to select a range of records.
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Record

• New - creates a new record. 

• Duplicate - makes a copy of the current record on the Data Entry Slip 
into a new record.  The date will be set to the present date & time. If the 
record type is Trip then the trip purpose might be changed to reflect the 
next logic trip point. 

• Beam - beams record to MPG on another Palm device.

Edit

The Edit menu consists of your standard Palm OS Edit menu. Any screen that 
has an input area for text will have the Edit menu available.
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3. 
Features

Chapters 2 and 3 covered basic transaction entry and navigation. This 
chapter covers all the other features of MPG.

List Editor
The editor is how you edit MPG customizable popup lists. Lists that are 
editable are: Categories, Payees, ID#s, Amounts, Currency Prefix, and 
Currency Suffix. Use the List Editor as follows:

• Select Edit in the popup list to bring up the List Editor so that you may 
add, rename or remove list items.

• To Add an Item to the List,tap New. 

• To Rename an Item, select the item you wish to rename and tap the 
Rename button. Enter the new name.

• To Remove an Item from the List, select the item, and tap Delete.
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Preferences

The MPG Preferences screen is accessed from the Options menu :

It includes the following items:

• Auto-add to popups - determines the behavior of the popups 
automatically. Check the check box to add any new location, payment, 
octance, service, or trip purpose  to their popup lists. 

• Hide ListView Scrollbar - hides the scroll bar in the log view. This 
speeds up the display. You can scroll the log view with the up and down 
buttons whether or not the scroll bar is displayed.

• Fillup decimal places - specifies the number of decimal places to use for 
theprice per gallon.

• Use PocketMoney-FPS - actives the MPG’s use of PocketMoney accounts 
for payments and allows posting of the financial transactions to 
PocketMoney

• Confirm posts to PocketMoney  - always display the PocketMoney Edit 
Transaction window so you can review the transaction being saved to 
PocketMoney.

• Post in category - the PocketMoney category to save the transaction 
under.
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Vehicle Info

The Vehicle Prefs screen allows you to supply detailed information about 
particular vehicles and set default values and behaviors for those vehcicles.

It includes the following data items:

• Vehicle - name as appears in the Vehicle lists. Write in the name of the 
new vehicle. 

• Units - determines what units to input and how fuel economy is 
calculated.

• Mileage  -is a reference for you only. Enter the number of miles on the car 
when you bought it. A new car would be zero and a used car be be 32,328. 
MPG does not use Starting Mieage for any computations, yet.

• VIN - acronym for Vehicle Identification Number, for reference.

• Plate # - license plate number, for reference.

• Engine Size- size of engine, for reference. 

• Notes - general notes, for reference.
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Creating a New Vehicle

From the Vehicle List screen tap . This opens a new Vehicle Info screen 
for you to name and enter the details for the new vehicle.

Deleting an Vehicle

Tap  to delete all information for the displayed vehicle. MPG asks 
you to confirm the deletion. The Delete button is located on the Vehicle 
Information screen.

Note: Deleting the vehicle deletes all records associated with that vehicle.

Custom Filters

Filters are a powerful way to display and report on subsets of records. MPG 
dynamically updates the views of the data represented by the currently 
chosen filter every time the screen is redrawn.

From the Log screen tap Menu and select Create Custom Filter from the View 
menu or write .

Pick which items you would like displayed:

• Vehicle - allows selection of particular vehicle or All Vehicles to 
include in the filter. Tap the Vehicle  and select the desired vehicle.

• Type - allows selection of Fuel, Service, Trip, or All Records to include in 
the filter. Tap the Account  and select the desired record type. 
Depending on the Type other Filter options will be available.
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H i n t :

Fuel: Filter on Octane.
Service: Filter on Service.
Trip: Filter on Purpose.

• Payment - allows selection of 
particular payment to include in 
the filter. Tap the Payment  
select tap the desired payment.

• Location - allows selection of 
particular location to include in the 
filter. Tap the Location  and 
select or write in the desired item.

• (Dates) From  - allows selection of a start date to include in the filter. 
Tap the From  to bring up the Date Editor.

• (Dates ) To - allows selection of ending date to include in the filter. Tap 
the To  to bring up the Date Editor.

Two special cases for Date To and Date From are:

Today : If selected MPG will replace “Today” with the current date 
whenever the filter is evaluated.

1st of Month : If selected MPG will replace ““1st of Month” with the 
first day of the current month. For example, if today is May 12, 2000 
then MPG will use May 1, 2000.

• Recent - allows selection of records which have changed or were added 
since the last HotSync. Check the Recent checkbox to show only recent 
changes. 

Several buttons at the bottom of the filter screen determine the disposition of 
the filter conditions:

• Tap Set to set the filter as defined in the Filter screen.

• Tap Cancel to close the Filter Conditions screen and leave the filter 
unchanged.
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• Tap Save to save the filter conditions with a name that you choose. That 
name now appears in the Custom Filter popup when you select the 
“Select Custom Filter...” option in the View menu.

• Tap Remove... to delete a previously saved filter.

Note: If you change a record value that does not conform to the current filter, 
the record will not appear in the Log Screen when you close the Data Entry 
Slip.

Multiple Users: IR Sync Option

If you and your spouse both use MPG then the IR Sync option is the preferred 
way to keep your vehicles in MPG in sync.

All Vehicles 
If you and your spouse share multiple vehicles and must have MPG in sync on 
both Palms then MPG’s IR Sync option makes it easy.

1. Spouse #1 opens to the Vechile List screen. 
2. Spouse #1 chooses IR Sync from the Options menu to beam unbeamed records 
to Spouse #2.
3. Spouse #2 accepts the incoming beam.
4. Spouse #2 performs steps 1 & 2.
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Selected Vehicles
If you and your spouse only share one vechile, but not your other vehicles then 
you need to do a couple extra steps. 

1. Spouse #1 opens the vehicle log that you want to sync.
2. Spouse #1 chooses IR Sync from the Options menu to beam unbeamed records 
to Spouse #2.
3. Spouse #2 accepts the incoming beam.
4. Spouse #2 performs steps 1 & 2.
5. Repeat steps 1-4 for any of the other vehicles that you want in sync.

Selected Records
Sort of like Selected Vehicles, but with more control. Create a Custom Filter 
for only the data you want to exchange. Any data being viewed will be 
beamed. Follow steps in Selected Vehicles, but instead of opening athe 
vehicle log, you want to select the custom filter criteria.

One Record
Go to the record you wish to beam. Select Beam from the Record Menu.
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4. 
Interfacing 
MPG with 
Desktop Applications

MPG supports importing and exporting of transactions via the MPG Conduit. 
There  are Macintosh and Windows conduits for PocketMoney. 

Installing Macintosh Conduit

1. Copy “MPG Conduit” to the Conduits folder located in the Palm Desktop 
folder.

2. Hotsync so the MPG conduit can create the folders in your user directory. 

Installing Windows Conduit

1. Exit HotSync by clicking the HotSync icon in the System tray and select 
Exit.

2. Copy “MPGCOND.DLL” to the same directory that the HotSync 
application is in.  (It is probably C:\Palm\ ).

3. If you have HotSync/PalmDesktop 3.0 installed then skip to step 5. 

4. If you have HotSync 2.0 then copy "CONDMGR.DLL" to the HotSync 
directory.

5. Double click the MPGCOND.REG file. This adds  necessary data to the 
Windows Registry for the MPG Conduit.

6. Run the HotSync application again. If everything installed correctly then 
you should see MPG in the custom settings listing.
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7. Hotsync so the MPG conduit can create the directories in your user 
directory. 

Import and Export Formats

Tab-delimited format (TDF) - standard format for interchanging data with 
databases and spreadsheets. 

Conduit Settings

Access to the MPG Conduit Setting is different on the Macintosh and 
Windows platforms. 

Macintosh: Open the HotSync application, choose Conduit Settings from the 
HotSync menu, double click the MPG line to open the MPG Conduit Settings 
window.

Windows: Click the HotSync button in the System Tray, select Custom, 
double click the MPG line to open the MPG Conduit Settings window.

HotSync Direction
• Update Handheld from Desktop - checking this will download 

“MPG.tdf” file located in the PocketMoney/ToPalm folder to MPG on the 
Palm.  

• Update Desktop from Handheld - checking this will upload data 
located from MPG on the Palm device to a file called “MPG.tdf” located 
in the MPG/FromPalm folder.  

• Upload All Transactions - checking this will upload all transactions 
from MPG, the current MPG.tdf file will be deleted before uploading the 
data. 

Leaving this unchecked will only upload transactions that have been 
changed since the last HotSync, the data will be appended to the current 
MPG.tdf  file. 
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Date Format
Choose the date format that of the data you will be importing and and the 
format you want to export you data as.
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Exchanging Data

Upload from Palm to Desktop: After you set all of the settings in the MPG 
Conduit Settings window then you can HotSync.  When HotSync is completed 
a MPG.tdf file will be located in the FromPalm folder. 

Refer to the user manual of your desktop program for importing and exporting 
tab delimited text data. 

Downloading from Desktop to Palm: Export the data from your database or 
spreadsheet program. Move the file to the ToPalm folder. HotSync. 
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